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Welcome To QuickReport 

QuickReport is a Microsoft WordTM based report generator.  QuickReport 
supports many standard Word features such as spell & grammar checking, 
insertion of tables and graphics, headers & footers, it also has the unique ability 
to import patient information and test results from the Sierra Wave program. 
 
QuickReport can be launched from within the Sierra Wave program (using the 
Print or Report keys) or it can be launched "stand-alone" by double clicking on its 
icon on the Window's desktop. 
 

 
 

QuickReport Icon 

 

 If launched "stand-alone" the program will not be able to import patient 
information or test results from the Sierra Wave program, but it can be used to 
generate other types of correspondence, as well as to edit/create report 
templates. 
 
 
Rev. 2.6.20 
2010 
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Getting Started 

Main Window 

The QuickReport application consists of three main Views. 
 

 
 

View #1 - Select Report 
 

The QuickReport program will open to this view if you select "Launch 
QuickReport & Select Template" from the Sierra Wave program's file menu. 
 This view is also displayed if you start QuickReport outside of the Sierra 
Wave program. 
 
The area on the left-hand side of the Select Report view lists all the available 
report templates.  Click on a template to select it, when selected a blue ball 
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with a yellow arrow will replace the green ball in front of the template's name. 
 Also, some summary information is displayed in the box above. 
 
Report templates on the Sierra Wave are global, that is the same report 
templates are available to all users of the computer.  As such, the "author" 
name will always appear as "SierraUser". 
 

 If there are no report templates listed in the "Select Report Template" 
area, right-click the mouse in this area and select Add Report Template 
from the pop-up menu. 

 
View #2 - Fill In Report 
 

The QuickReport program will go to this view if you select a report template 
that requires user input.  For example, the pre June 2005 "Full Report" and 
"Full Report with Sentence Gen" templates will proceed to this view so that 
the user can make selections for Chief Complaints, Findings, and 
Impressions.  On a Sierra Wave purchased after June 2005, only the "Full 
Report" template will proceed to this view so that selections for Findings can 
be made. 

 
View #3 - Document 
 

This view shows the generated report in Word format.  The QuickReport 
program will go directly to this view if you select a report template that does 
not require any user input, the "Current Test", "TabData w/ Traces", and 
"TabData w/o Traces" templates are examples.  The program will also switch 
to this view when all selections have been completed on the Fill In Report 
view. 
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Select Report View 

This view allows you to choose any report template on the system. 
 

 
 

To Select a Report Template: 
 

 Single click on the report template to select it, then click the Next 
button. 

 
 Double click on the report template. 
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Fill In Report View 

The QuickReport program will go to this view if you select a report template that 
requires user input.  For example, the "Full Report (manual Findings)" template 
will go directly to this view so that the user can make selections for Findings. 
 
Selections are made by simply clicking on the on the green arrow , when the 
selection is made the arrow is shown in red.  As selections are made the 
resulting sentence is shown at the bottom of the window. 
 
The example shown below illustrates this for Abnormal Motor Nerve Findings. 

 

 
 

Findings Item - click on green arrows to make selections. 

 
Click the Done and/or OK button when all selections have been made for an 
item. 
 
After the last item is completed the program automatically proceeds to the 
Document view. 
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Making Changes to Previous Selections 
 

You can go back to the Fill In Report view from the Document view.  This 
allows you to make changes to any of the selections that were made the first 
time through the template.  From the Document view, simply click on the 
Back button at the bottom right of the screen.  To make changes to any of 
the selections, click on the green arrow  or click on the item's label in the 
box shown on the left hand side of the screen.  After making your changes, 
click the Next button to generate a new report with your changes. 

 

 
 

Fill In Report view - after returning from Document view. 
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Document View 

The Document view shows the generated report in Microsoft WordTM format.  The 
QuickReport program will automatically go to this view if you select a report 
template that does not require any user input, the "Current Test", "TabData w/ 
Traces", and "TabData w/o Traces" are examples of this kind of template.  The 
program will also switch to this view when all selections have been completed on 
the Fill In Report view. 
 

 
 

Document view. 

 
The finished report document contains all the information specified in the report 
template.  Usually, the document will start with a Header that contains the 
address for the clinic or hospital.  Next, the patient information is typically 
displayed followed by the test results and traces. 
 
Anything within the document can be edited.  Simply click the mouse where you 
want to make a change, the blinking cursor will appear.  Use the backspace key 
to delete the text then re-type the text the way you want it.  To add to the report, 
click on a blank line, then type the text you want. 
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If you want to delete an entire row from a table, like the EMG Muscle Score table, 
click the mouse anywhere in the row you want to delete.  The blinking cursor will 
appear.  Now, select “Delete-Row” from the Table menu at the top of the screen. 
 If you make a mistake, select “Undo” from the Edit menu. 
 
To insert a page-break, click the mouse above the line where you want the new 
page-break to start.  Then, select Page Break  from the Insert menu. 
 
Use the formatting toolbar to make changes to the text size, add bolding, or 
italics, or change the font style. 

Printing the Report 

To Print the Report 
 
From the Document view, perform one of the following. 
 

 Click on the Printer icon at the top of the screen.  The report will be 
sent to your default printer. 

 
 Select Print from the File menu.  A standard Window's Print dialog will be 

displayed. 
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If necessary, select the Printer, choose the number of copies, then click 
the OK button. 

Saving the Report 

To Save the Report 
 
From the Document view, perform one of the following. 
 

 Click on the diskette icon . 
 

 Select Save from the File menu. 
 

 Click on the Finish button in the bottom right of the screen. 
 
Clicking on either the diskette icon or selecting Save from the File menu will 
display a standard Window's Save-As dialog.  The "Save In" location defaults to 
the current user's Data folder.  Click the Save button  to save the report to this 
location. 
 

 
 
 
Clicking on the Finish button will display the following message. 
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Clicking Yes will automatically save the report document to the current user's 
Data folder. 
 
 

 Reports are saved in Word format with the DOC file extension.  The 
filename of the report document is automatically created based on the patient's 
"lastname" and "firstname", and the "date" and "time" of the exam.  The name of 
the report template is also included in the filename, after the ~ symbol.  By 
default, reports are saved to the data folder specified in the Sierra Wave's 
System Setup window. 
 

Closing QuickReport 

To Close QuickReport 
 
From the Document view, perform one of the following. 
 

 Click the Finish button at the bottom right of the screen. 
 

 Click the Red X in the top right-hand corner. 
 

 If the report has not been saved the program will ask you if you would like to 
save the report before exiting. 
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Editing Report Templates 

Launch QuickReport 

Before you can edit report templates the QuickReport program must be started. 
 
To Start QuickReport from within the Sierra Wave program: 
 

From the File menu, select Launch QuickReport & Select Template.  This 
selection is only available if a patient data file is open. 

 
To Start QuickReport stand-alone: 
 

Double click on the QuickReport icon on the Windows desktop.  When 
QuickReport is started as a stand-alone program you can easily edit 
templates but be aware that generated reports will not contain any Sierra 
Wave tables, waves, or patient information. 
 

 
QuickReport Icon. 

What is a Report Template? 

A report template is a file that contains specific commands, called Items, that tell 
the QuickReport program what data to obtain from Sierra Wave and include in 
the final report document.  Items can also contain pre-formatted “text”, like labels 
such as “Patient:” or “DOB:”, or a signature line, or even entire paragraphs for 
things like Findings or Conclusions. 
 
The order of the items in the report template is important because the printed 
information will also appear in this order on the created document.  So, if the first 
part of the report template contains a patient information item and then is 
followed by the item for Tabdata, this is the order it will appear on the report 
document as well. 
 
Items are also used to change the format of the report.  If an item containing the 
command for a font size of 9 pt. is placed before the item for Tabdata, the 
Tabdata tables in the created document will be seen as 9 pt. 
 
To change the order of items in a report template, insert new items, or edit 
existing items, you must enter the Template Edit mode. 
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Edit Mode 

To enter Template Edit mode: 
 

From the Select Report view: 
 

 Right click on the template's name, select Edit "Template Name" 
 

 
 

Result of right-clicking on the Full Report (manual Findings) template. 

 
From the Fill In Report view: 

 
 From the View menu, select Edit Template. 

 
 
After Template Edit mode is enabled you will see the Item Labels, for all the 
items contained in the report template, listed down the center of the screen. 
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Template Edit mode with items listed in the center section. 

 
Right-clicking on an Item Label will display the following menu.  These 
functions will be covered in the help topics that follow. 
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Result of right-clicking on an Item Label. 
 

 

Items - The building blocks of templates. 

As mentioned earlier, Items are the basic building blocks of report templates. 
 Items are used to insert Sierra Wave test data, patient information, formatting 
and style information, pre-programmed paragraphs, pictures, and page headers 
and footers, into the template. 
 
There are seven Item Types, each type can insert specific information into the 
template. 
 



Editing Report Templates 

17 

Description of Item Types: 
 
#1 - The Paragraph Item. 
 

This item type is used to create sentences or paragraphs of information.  This 
is done by selecting complete paragraphs or by completing pre-programmed 
sentences by choosing from lists of words or phrases.  As such, the 
Paragraph Item has functions for entering text and composing choice lists. 
 Paragraph items can also contain special commands, called "Tokens", to 
insert patient information, test information, or formatting tags (see below). 
 
The Preview area (shaded light blue) at the top of the window shows the 
results of the current selections. 
 

 
 

Example Paragraph Item with alternating text & choice boxes. 
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#2 - The Insert Item. 
 

This item type is used to format the report.  The Insert item can add page 
breaks, headers, footers, insert other documents and pictures, adjust margins 
and tab stops, and insert style changes (i.e., font size and type).  Header and 
Footer items can also contain special commands, called "Tokens", to insert 
patient information, test information, or formatting tags. 
 

 
 

Example of an Insert Item.  This one inserts the contents of another 
document, called "ReportHeader", into the template. 

 
#3 - The Sierra Item. 
 

This item type is used to place Sierra Wave data into the template.  This 
includes results tables, traces, and NCV/EMG Sentence Generator 
sentences. 
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Example of a Sierra Item, this one inserts the all the TabData tables. 

 
#4 - The Select Item. 
 

This item type is used to complete sentences by choosing words or phrases 
from a pre-defined list.  It is somewhat similar to the Paragraph item with the 
exception that you can't place pre-defined text between your choice lists like 
you can in a Paragraph item.  A Select item also comes with pre-defined 
buttons for selecting words such as "and", "or", "with", "was", "the", "not", and 
more.  Select items can also contain special commands, called "Tokens", to 
insert patient information, test information, or formatting tags. 
 
The Preview area (shaded light blue) at the top of the window shows the 
results of the current selections. 
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Example of a Select Item called Chief Complaints. 

 
#5 - The Narrative Item. 
 

This is probably the most powerful item type and is used to group other 
Paragraph, Select, or Multi items into a single selection menu.  For example, 
you could group all the Paragraph items that are used for completing the 
Findings section of the report into a single menu.  This will allow you to 
choose the appropriate items from a large list during report generation. 
 
The Preview area (shaded light blue) at the top of the window shows the 
results of the current selections. 
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Narrative Item.  This example groups all the individual Paragraph items that 
involve EMG/NCV Findings into one complete menu.  In the above example the 
Normal EMG item has already been selected, this is indicated by the "red" arrow 
and by the text shown at the top of the window. 

 
#6 - The Table Item. 
 

This item type is used to build a table of patient & test information.  The 
number of rows and columns can be specified and the individual cells within 
the table can contain simple text or "Tokens". 
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Example Table Item.  This item is called "Patient Block" and is used 
to insert patient demographics, in table form, into the template. 

 
#7 - The Multi Item. 
 

The Multi Item is not used in Sierra Wave report generation and therefore will 
not be discussed in this Help file. 
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Patient and Test Information Tokens and Formatting Tags: 
 
As mentioned above, the Paragraph, Select, Table, and Insert items can contain 
special commands called "Tokens" and Formatting Tags.  These special 
commands can only be placed into the item in the Edit Item mode, see Editing 
Items. 
 

Tokens are entered by clicking on the token button .  This will display a 
menu that allows the selection of a specific Patient Information, Test 
Information, or Current Date/Time command.  When a token is inserted into 
an item it has a characteristic appearance, it begins with a less than symbol 
(<) and ends with a forward slash and a greater than symbol (/>).  In the 
above Select Item example the token for patient age is shown as follows. 
 

<DATA "PATIENT.AGE"/> 
 
When the report template is processed this command will be replaced by the 
patient's age. 
 

Formatting Tags are entered by clicking on the formatting button .  This 
will display a menu that allows the selection of commands for Bold, Underline, 
Italics, and more.  In the above Narrative Item example the word "Findings" is 
bracketed by a Bold command (<B>) command and a Bold Off command 
(</B>). 

 
 

Auto Selected Items 

When an item requires no user interaction during report generation it should have 
a check mark in its associated Auto Select box.  These are usually items that 
insert tables, waves, formatting, page breaks, and carriage returns (i.e., blank 
lines).  QuickReport will automatically process and insert all "auto-selected" items 
into the report document. 
 
When an Item does require user interaction (e.g., selections need to be made by 
the user to complete a findings sentence), the item should not have a check mark 
next to Auto-Select.  QuickReport will pop-up all non-Auto Selected items in 
sequence during report generation so that the user can make the appropriate 
selections. 
 
The following example shows the items in the factory default Full Report 
(manual Findings) template, all items are Auto-Selected except for EMG/NCV 
Findings.  This item requires the user to make selections during report 
generation so it must be left un-checked. 
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Inserting Items into a Template 

To Insert an Item into a Template: 
 

 Locate the item you want by expanding the appropriate Item Category in 
the Available Item List.  This is done by clicking on the plus sign (+) in 
front of the category.  Clicking on the minus sign (-) will contract the 
category. 

 
 Using the left mouse button, Drag the report item and Drop it onto the 

template's item list in the center section of the screen.  A red line appears 
to indicate where the item will be placed when the mouse button is 
released. 
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Deleting Items from a Template 

To Delete an Item from a Template: 
 

 Right-click the mouse over the template item you want to delete. 
 

 Select Delete from the pop-up menu. 
 

 The item will be removed from the template. 

Cut, Copy, & Paste Items 

To Cut or Copy an Item within a template: 
 

 Right click the mouse over the item that you want to cut or copy. 
 

 Select Cut or Copy from the pop-up menu.  The item will be placed in the 
Window's clipboard. 

 

 
To Paste an Item into a template: 
 

 Right click the mouse over an existing item in the template.  (The 
pasted item will be inserted below the item that you right click on.) 

 
 Select Paste "Item Label" from the pop-up menu. 

 
 The Item on the Window's clipboard will be pasted into the template. 

Drag & Drop Items 

You can change the order of items in the template using the Drag & Drop 
method. 
 
Simply left mouse click on the template item you want to move.  Keep the left 
mouse button pressed down and drag the item up or down within the item list.  A 
red line will appear indicating where the item will be positioned when the mouse 
button is released. 
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Control Check Boxes 

In Template Edit mode there are four Control Boxes shown in a separate 
window. 
 

 
 

Control Check boxes. 

 
Auto Start 
 

This box should normally be checked if there are non-Auto Selected items in 
the template.  This will cause QuickReport to automatically pop-up the first 
non-Auto Selected item in the template after the template is selected for 
report generation. 

 
Auto Advance 

 
This box should be checked if there are more than one non-Auto Selected 
items in the template.  This will cause QuickReport to automatically advance 
to the next non-Auto Selected item in the template after the first one is 
completed. 

 
Auto Create Document 
 

This box is normally checked for all templates.  This will cause QuickReport to 
automatically go to the Document view upon completion of all the items in the 
template.  This box should even be checked when the template contains all 
Auto-Selected items. 

 
Auto Save 

If this box is checked the report will be generated and automatically saved to 
the default Data folder.  There will be no opportunity to view the report in the 
Document view.  This box can only be used with templates that contain all 
Auto-Selected items.  This box is not checked for any of the factory default 
templates. 
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Auto Print 
 

If this box is checked the report will be generated and automatically sent to 
the default printer.  There will be no opportunity to view the report in the 
Document view or to save the report.  This box can only be used with 
templates that contain all Auto-Selected items.  This box is not checked for 
any of the factory default templates. 
 

Auto Protect 
 

If this box is checked the generated report will automatically be displayed in 
"protected" mode.  This allows templates that contain Word forms (e.g., check 
boxes, lists) to be completed but not altered. 

Saving Changes 

To Save changes made to a template: 
 

Perform one of the following. 
 

 Click on the diskette icon . 
 

 Select Save from the File menu. 
 

 Click the Save button in the Edit Template window 
 
 

To Save the changes as a new template: 
 

 Click the Save As button in the Edit Template window.  The Edit Report 
Template Information window will be displayed. 
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Edit Report Information window. 
 

 Enter a Name and Description for the new template, then click OK. 
 

 The new template will automatically be added to the list of templates in the 
Select Report view. 
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Item Types 

Item Index 

Paragraph Item 
 
Insert Item 

 Page Break 

 Style 

 Picture 

 Document 

 Margins 

 Header & Footer 

 Tab Stops 

 
Sierra Item (Waves & TabData) 
 
Select Item 
 
Narrative Item 
 
Table Item 
 
Multi Item 

Paragraph Item 

The Paragraph Item is used to create and insert sentences or paragraphs of 
information into the report.  This is achieved by selecting complete paragraphs or 
by completing pre-programmed sentences by choosing from lists of words or 
phrases.  As such, the Paragraph Item has functions for entering text and 
composing choice lists.  Paragraph items can also contain special commands, 
called Tokens, to insert patient information, test information, or formatting tags. 
 
Shown below is an example paragraph item called "Abn Motor".  It is composed 
of Select, Text, and Choice boxes and is used to compose a findings sentence 
for motor nerve conduction results. 
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Abn. Motor paragraph item. 
 

Select Box - click on a word to select it, more than one 
selection can be made.  The results of the selections are 
shown in the box below. 
 
Choice Box - click on the green arrow ( ) to make a 
selection, the arrow changes color to red to indicate this 
choice has been selected.  Choice boxes can be setup to 
allow more than one selection to be made.  However, unlike 
Select boxes, Choice boxes automatically insert the word 
"and" between two selections, and also insert a comma "," if 
there are more than two selections made. 
 
Preview Area - this area (shaded light blue) shows the 
sentence that results from the selections that were made. 
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 Blank underlined sections indicate where selections or 
choices will need to be made in order to complete the 
sentence. 
 
 

Shown below is an example of a simple paragraph item called "Signature from 
Patient Info".  It consists of a single Text box that inserts a couple of blank lines 
and provides a signature line for the physician.  It also includes a special 
command, called a Token, that inserts the physician's name (as entered into the 
Sierra Wave's patient information window) beneath the signature line.  This type 
of paragraph item would normally be marked as an Auto Selected item in the 
template. 
 

 
 

Signature from Patient Info paragraph item. 
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Shown below is another example of a simple paragraph item called "Normal UP 
NCV".  It consists of a single text box with sentences describing normal nerve 
conductions and F waves for the upper extremities. 
 

 
 

Normal UP NCV paragraph item. 

 
 

Paragraph Item Buttons 
 

The buttons that will be available at the bottom of the Paragraph Item will vary 
depending on whether the item is used as a stand-alone item in the template or 
whether it is nested within a Narrative Item. 
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When the Paragraph Item is used stand-alone (outside of a Narrative 
Item): 
 

 
Clicking the Edit button will open an edit mode where 
permanent changes can be made to the item. 
 

 
Clicking the Deselect button will 'undo' all selections 
that have been made within the item so you can make 
new selections. 
 

 
Clicking the Normal button will automatically select the 
choices that have been programmed as the normal 
selections for the item. 
 

 
When this box is checked the program will 
automatically advance to the next item in the template 
after the Done button is clicked.  If the box is not 
checked the program will go back to the Fill In Report 
view. 
 

 
When the Done button is clicked the item will be closed 
and any selections will be processed. 

 
When the Paragraph Item is used within a Narrative Item: 

 

 
When the Done button is clicked the item will be closed 
and selections processed. 
 

 
Clicking the Cancel button will close the item and any 
selections will be ignored. 
 

 
Clicking the Deselect button will 'undo' all selections that 
have been made within the item so you can make new 
selections. 

 
 

 

Adding additional Text or Choices to a Paragraph Item during report 
generation. 
 
During report generation Paragraph items can be edited on-the-fly.  The method 
used to make the edits will depend on how the item is used within the template. 
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When the Paragraph Item is used stand-alone (outside of a Narrative 
Item): 

First click the Edit button to enter edit mode, this is the same mode 
that is seen when creating a new Paragraph item.  To add additional 
text to any Text box, simply type in the appropriate box.  Additional 
choice selections can be added to a Choice box by first clicking the 
mouse after the last choice listed within a box and then pressing the 
Enter key, a blank choice line will appear.  Now simply type the word or 
words for the new choice. 
 
To add additional selections to a Select box, right click the mouse 
within the select box and choose Insert Word from the pop-up menu. 
 Type the new word in the box provided, then press the Enter key. 
 

Insert Token button - click here to add a Patient or Test 
Information token to the associated box.  See the Tokens 
topic for more information. 
 

Insert Formatting button - click here to add a formatting 
tag to the associated box.  See the Formatting Tags topic for 
more information. 
 
 
Click the Update button to save your changes. 
 

 
 
 
When the Paragraph Item is used within a Narrative Item: 

Additional choice selections can be added to a Choice box by first 
clicking the mouse after the last choice listed within a box and then 
pressing the Enter key, a blank choice line will appear.  Now simply 
type the word or words for the new choice. 
 
To add selections to a Select box, right click the mouse within the 
select box and choose Insert Word from the pop-up menu.   Type the 
new word in the box provided, then press the Enter key. 
 
To save the choice or select box additions permanently, place a check 
mark in the Save Changes box at the bottom of the item's window. 
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Text boxes cannot be edited during report generation, you must use 
the Edit button on the main Narrative window and then select the 
Paragraph item you wish to edit. 

 
 

Insert Item 

The Insert Item is used to format the report.  The Insert item can add page 
breaks, headers, footers, insert other documents and pictures, adjust margins 
and tab stops, and insert style changes (i.e., font size and font type).  Header 
and Footer items can also contain special commands, called "Tokens", to insert 
patient information, test information, or formatting tags. 
 
Insert Items are usually always marked as Auto Selected items within the report 
template.  As such, they do not require any user interaction during report 
generation. 
 
 

Insert Item Types 

Insert - Page Break 

The Insert - Page Break item is used to create a 'manual' page break within the 
report document.  Page breaks allow you to separate individual parts of your 
report document (e.g., you could have the first page include patient information, 
findings, and impression, then have the second page start with the results table). 
 
This type of item is typically marked as Auto Selected in the report template.  As 
such, no user interaction is required during report generation. 
 
Shown below is an example of an Insert - Page Break item in the Create/Edit 
mode.  Note that Page Break is selected in the Type area. 
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Insert - Page Break example. 
 

 
 
 

Insert - Style 

The Insert - Style item is used to set the format of the report.  Multiple style 
items can be included in a report template allowing various sections of the report 
to have different font sizes, font styles, or margins. 
 
This type of item is typically marked as Auto Selected in the report template.  As 
such, no user interaction is required during report generation. 
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Shown below is an example of an Insert - Style item in the Create/Edit mode. 
 Note that Style is selected in the Type area.  In this case, the style is called 
Normal Paragraph and sets the font to Times New Roman, 12pt, Left Justified. 
 

 
 

Insert Style item example. 
 

 
Clicking on either the Browse or Edit buttons will display the Quick Report 
Style Editor window.  This window allows you to select from one of the pre-
programmed styles (first 10 styles listed) or a user defined style (User Style 1-
10).  The pre-programmed styles cannot be altered. 
 
By selecting a User Style you can then select the Font Name, Font Size, Font 
Color, Bold, Italic, Underline, Alignment (Justification), Line Spacing, and 
Indentation. 
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Edit Style window. 
 

 

Insert - Picture 

The Insert - Picture item is used to place external graphics files into the report 
document.  For example, you could insert a clinic logo, an anatomy picture, or a 
picture of the patient. 
 
The picture formats support are BMP, JPG, and GIF. 
 
Insert - Picture items should be marked as Auto Selected in the report template 
if the picture needs to be inserted all the time without user interaction. 
 
The example shown below is for an item called Brachial Plexus, it can be used 
to insert a picture of the brachial plexus anatomy into the report. 
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Insert - Picture example. 
 

Clicking the Browse button displays a standard File-Open dialog allowing you to 
locate and select any picture file on the computer.  
 

Insert - Document 

The Insert - Document item is used to insert the contents of another document 
into the report.  The factory default templates all use an Insert - Document item to 
insert the Report Header at the top of the first page in the report. 
 
The document formats that are supported are txt, rtf, doc, docx, dot, dotm, and 
xml. 
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Insert - Document items should be marked as Auto Selected in the report 
template if the document needs to be inserted all the time without user 
interaction. 
 
The example shown below is for an item called Insert ReportHeader.doc, it is 
used to insert the report header specified in the Sierra Wave's System Setup 
menu into the report. 
 

 
 

Insert - Document example. 
 

 
Clicking the Browse button displays a standard File-Open dialog allowing you to 
locate and select any document file on the computer. 
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Insert - Margins 

The Insert - Margins item can be used to specify the margins for the entire 
report document and also to specify the margins for different sections within the 
report document. 
 
This type of item is typically marked as Auto Selected in the report template.  As 
such, no user interaction is required during report generation. 
 
The example shown below is for an item called Margins 0.5 inches - Portrait, it 
is used in all the default factory report templates to set the margins at 0.5 inches 
for Left, Right, Top and Bottom, and also to set the page layout to Portrait mode. 
 

 
 

Insert - Margins example. 
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Insert - Header & Footer 

The Insert - Header and Insert - Footer items are used to insert a block of text 
at the top or bottom of every page in the report.  Typically this includes the 
patient's name, test date, and page number. 
 
This type of item is typically marked as Auto Selected in the report template.  As 
such, no user interaction is required during report generation. 
 
The example shown below is for an item called Page Header, it is used to insert 
the patient's name, test date, and page number at the top of every page in the 
report.  Note that the first page of the report can be skipped (Skip first page 
check box). 
 

 
 

Insert - Header example. 
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Headers and Footers are created by entering Text, Tokens and Formatting 

Tags into the designated box. 
 

Insert - Tab Stops 

The Insert - Tab Stops item can be used to override the default 0.5 inch tab 
stops in the report document. 
 
This type of item is typically marked as Auto Selected in the report template.  As 
such, no user interaction is required during report generation. 
 
The example shown below is for an item called Tabs - 1 inch, it is used to set 
the tab stops to 1 inch. 
 

 
 

Insert - Tab Stops example. 
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Sierra Item (Traces & TabData) 

The Sierra Item is used to place Sierra Wave test data into the report.  This 
includes traces, results tables, stimulus tables, and NCV/EMG Sentence 
Generator options. 
 
This type of item is typically marked as Auto Selected in the report template.  As 
such, no user interaction is required during report generation.  However, the 
exception to this rule would be when using the Sentence Generator options, 
these should never be Auto Selected. 
 
The example shown below is for an item called All Tables, it is used to insert the 
results tables for all tests performed during the exam into the report. 

 

 
 

Example of a Sierra Item, this one inserts the all the TabData tables. 

 
When a Sierra Item is created the Sierra Value and Available Tests fields must 
be indicated. 
 

Sierra Value Available 
Tests 

Function 

Markers* Not applicable. Inserts a table showing the values 
for the Time and Amplitude 
markers in the current test only. 
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Results* Not applicable. Inserts a table of auto-cursor 
values for the current test only. 

Stim History* Not applicable. Inserts a table showing the stimulus 
parameters, display gain, hicut, 
locut, and sweep speed for each 
trial/trace in the current test only. 

Stim History 
(All EP Tests) 

Not Applicable. Inserts a stimulus history table for 
every EP test protocol in the data 
file. 

AEP Amp 
History 

Not Applicable. Inserts a table showing the 
amplifier settings for the AEP test 
protocol. 

TabData All, AEP, Blink, 
EMG, F-Wave, H-
Reflex, NCV, RNS, 
SEP Lower, SEP 
Upper, SFEMG, 
SSFEMG, VEP, 
P300, MUNE-Incr, 
MUNE-MPS, RR 
Interval, Real-time 
SFEMG, Macro 
EMG, and EMG 
Guidance. 

Inserts summary tables for all the 
tests performed on the patient (All) 
or for a selected test. 

TabData Waves All, AEP, Blink, 
EMG, F-Wave, H-
Reflex, NCV, RNS, 
SEP Lower, SEP 
Upper, SFEMG, 
SSFEMG, VEP, 
P300, MUNE-Incr, 
MUNE-MPS, RR 
Interval, Real-time 
SFEMG, Macro 
EMG, and EMG 
Guidance. 

Inserts trace graphics for all the 
tests performed on the patient (All) 
or for a selected test. 

Waves* Not applicable. Inserts the trace graphics for the 
current test only. 

NCV Sentence Not applicable. Inserts the results of the NCV 
sentence generator from the 
TabData window. 

EMG Sentence Not applicable. Inserts the results of the EMG 
sentence generator from the 
TabData window. 

NCV and EMG 
Sentence 

Not applicable. Inserts the results of both the 
NCV/F/H and EMG  sentence 
generator from the TabData 
window. 
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NCV/F/H 
Sentences 

Not applicable Inserts the results of the NCV, F, 
and H sentence generator from the 
TabData window. 

F Wave 
Sentence 

Not applicable Inserts the results of the F Wave 
sentence generator from the 
TabData window. 

H-Reflex 
Sentence 

Not applicable Inserts the results of the H-Reflex 
sentence generator from the 
TabData window. 

EP Sentence Not applicable. Inserts the results of the EP 
sentence generator (All EP Tests) 
from the TabData window. 

EP Sentence 
for Current Test 

Not applicable. Inserts the results of the EP 
sentence generator (currently 
selected EP test only) from the 
TabData window. 

TabData L/R 
Diff 

NCV Inserts summary tables for the NCV 
Left vs. Right side difference 
measurements. 

DataLAB Table Not applicable. Inserts a summary table showing 
all DataLAB results for the patient. 

AnatomyVIEW 
Muscles 

Not applicable. Inserts the AnatomyView Muscle 
Data graphic for the patient. 

AnatomyVIEW 
Nerves 

Not applicable. Inserts the AnatomyView Nerve 
Data graphic for the patient. 

MMUA Table Not applicable. Inserts the MMUA results table for 
the patient. 

MMUA Waves Not applicable. Inserts a summary of the MMUA 
traces for the patient. 

Real Time 
SFEMG 
Summary 

Not applicable. Inserts a table containing only the 
summary information from the Real 
Time SFEMG test protocol. 

 
 * These items are only used in the default factory report template, 
"Current Test". 
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Select Item 

The Select Item is used to complete sentences by choosing words or phrases 
from a pre-defined list.  It is somewhat similar to the Paragraph item with the 
exception that you can't place pre-defined text boxes between your choice lists 
like you can in a Paragraph item.  A Select item also comes with pre-defined 
buttons for selecting words such as "and", "or", "with", "was", "the", "not", and 
others.  Select items can contain special commands, called Tokens, to insert 
patient information, test information, or formatting tags. 
 
Shown below is an item called Complaints.  It is used to complete one or more 
sentences regarding the patient's complaints. 
 
Click on a word, phrase, or button to complete the initial sentence shown in the 
Preview area at the top of the window. 
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Example of a Select Item called Chief Complaints. 
 

Select Item Buttons 
 

The buttons that will be available at the bottom of the Select Item will vary 
depending on whether the item is used as a stand-alone item in the template or 
whether it is nested within a Narrative Item. 

 
When the Select Item is used stand-alone (outside of a Narrative Item): 
 

 
Clicking the Edit button will open an edit mode where 
permanent changes can be made to the item. 
 

 
Clicking the Deselect button will 'undo' all selections 
that have been made within the item so you can make 
new selections. 
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Clicking the Normal button will automatically select the 
choices that have been programmed as the normal 
selections for the item. 
 

 
When this box is checked the program will 
automatically advance to the next item in the template 
after the Done button is clicked.  If the box is not 
checked the program will go back to the Fill In Report 
view. 
 

 
When the Done button is clicked the item will be closed 
and any selections will be processed. 

 
When the Select Item is used within a Narrative Item: 

 

 
When the Done button is clicked the item will be closed 
and selections processed. 
 

 
Clicking the Cancel button will close the item and any 
selections will be ignored. 
 

 
Clicking the Deselect button will 'undo' all selections that 
have been made within the item and will then close the 
item. 
 

 Clicking the Reset button will return the item back to its 
default state so that all new selections can be made. 
 

 Clicking this button will clear all previous selections and 
the initial sentence. 
 

 
 

 

Adding additional choices to a Select Item during report generation. 
 
During report generation Select Items can be edited on-the-fly.  The method used 
to make the edits will depend on how the item is used within the template. 
 

When the Select Item is used stand-alone (outside of a Narrative Item): 
First click the Edit button to enter edit mode, this is the same mode 
that is seen when creating a new Select item.  Type the new word or 
phrase into the box provided and then click the Add button.  You can 
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use the Delete button to remove selections and the up/down arrows to 
change the order of the selections. 
 

 
 

Alphabetize button  - click here to automatically 
alphabetize all the words in the list. 
 

Insert Token button - click here to add a Patient or Test 
Information token to the associated box.  See the Tokens 
topic for more information. 
 

Insert Formatting button - click here to add a formatting 
tag to the associated box.  See the Formatting Tags topic for 
more information. 
 
Click the Update button to save your changes.   
 

 
 
When the Select Item is used within a Narrative Item: 

Type the new word or phrase into the box provided at the bottom of the 
window, then click the Add button. 
 

 
 
Click the Done button to save your changes. 
 

 
 

 

Narrative Item 

The Narrative Item is the most powerful item type and is used to group other 
Paragraph, Select, Insert, or Multi items into a single selection menu.  For 
example, you could group all the Paragraph items that are used for completing 
the Findings section of the report into a single selection window.  This will allow 
you to choose the appropriate items from a large list during report generation. 
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Shown below is an example Narrative item called EMG/NCV Findings.  This 
item groups all the individual paragraph items, that involve EMG/NCV Findings, 
into one complete menu.  The Normal EMG item has already been selected, this 
is indicated by the "red" arrow and by the text shown in the Preview area at the 
top of the window.   

 

 
 

Narrative Item - example. 
 

Selecting Items: 
Click on an item to select it.  As each item is selected its individual 
content window (Paragraph, Select, or Multi) will be displayed.  This 
allows the contents of the item to be confirmed and any selections 
within the item to be made.  After clicking the Done button the item's 
contents will be displayed in the preview area at the top of the 
Narrative. 
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Item Copies: 
The program can automatically place a copy of selected items into the 
Narrative list (Normal EMG [Copy #2] shown in the above example). 
 This allows the item to be used again so that different selections can 
be made. 
 
Preview Box: 
You can click the mouse within the Preview text box (shaded light blue) 
and simply type to add additional text or press the Enter key to create 
blank lines. 
 
Check Boxes: 

 
 

Include Heading - when this box is checked the text entered in the 
box to the right will be inserted into the report as a heading (the text 
is automatically bolded and a colon (:) is added). 
 
Heading on Separate Line - when this box is checked the results of 
the Narrative will be placed on the line below the heading rather 
than starting on the same line as the heading. 
 
List 

 Numbers  - when this option is enabled each selected item in 
the Narrative will be numbered in the report.  This is shown in 
the example below. 

 

 
Numbered items. 

 

Bold  - when checked, the numbers will be displayed in 
bold text. 
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MS Word Style - when checked, the format & style that is 
used for the numbers will be taken from Word's Normal 
template. 
 

 Bullets - when this option is enabled each selected item in 
the Narrative will be bulleted in the report. 

 
Bold - when checked, the bullets will be displayed in bold 
text. 
 
MS Word Style - when checked, the format & style that is 
used for the bullets will be taken from Word's Normal 
template. 

 
Show Copies - when checked, a copy of selected items is shown in 
the Narrative list (Normal EMG [Copy #2] shown in the above 
example).  This allows the item to be used again so that different 
selections can be made.  When unchecked, copies of selected items 
are not shown in the Narrative list. 

 
Ordering Options: 

 
 

Order As Selected - when this option is selected the items will 
appear in the report in the order they were selected within the 
Narrative. 
 
Order As Listed - when this option is selected the items will always 
appear in the report in the same order listed in the Narrative, not in 
the order they were selected. 

 
 

Narrative window buttons: 
 

 
Clicking the Edit button will open the Narrative edit 
mode window.  The edit window can be used to make 
permanent changes to each item assigned to the 
Narrative and to add or delete items. 
 

 
Clicking the Deselect button will 'undo' all selections 
that have been made within the Narrative so you can 
make new selections. 
 

 
Clicking the Normal button will automatically select 
those items that have been programmed as the normal 
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default selections for the Narrative. 
 

 
When this box is checked the program will 
automatically advance to the next item in the template 
after the Done button is clicked.  If the box is not 
checked the program will go back to the Fill In Report 
view. 
 

 
When the Done button is clicked the Narrative will be 
closed and any selections will be processed. 

 

 

Table Item 

The Table Item  is used to build a table of patient & test information.  The 
number of rows and columns can be specified and the individual cells within the 
table can contain simple text or "Tokens". 
 
Table Items are usually always marked as Auto Selected items within the report 
template.  As such, they do not require any user interaction during report 
generation. 
 
The example shown below is an item called Patient Block.  It is used to insert 
patient demographics, in table form, into the report.  This item is used in all the 
factory default templates. 
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Table Item example. 

 
Shown below is the result of the Patient Block item as seen in the 
report document. 

 
 

 

Multi Item 

The Multi Item is not used in Sierra Wave report generation and therefore will 
not be discussed in this Help file. 
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Report Item Editor 

Opening the Report Item Editor 

The Report Item Editor allows you to Create, Edit, and Delete items without 
having to first open a report template in Edit mode. 
 

To Open the Report Item Editor 
 

From Within the Sierra Wave program: 
 

 Select Launch QuickReport and Select Template from the File 
menu. 

 
From the Windows Desktop: 
 

 Double click the QuickReport icon. 
 

After the QuickReport window is displayed, select Edit Items from the File 
menu.  The Report Item Editor will be displayed. 
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Report Item Editor window. 

 
 

Item categories are indicated by this icon .  Click the plus sign (+) in front of a 
category name to view the individual items that are stored within that category. 
 

 For a description of all the factory default report items, click here. 
 
To select an item, single click on the item's name to highlight it.  The bottom 
section of the window will display a list of all the Templates and/or Narrative 
Items that the selected item is used in. 
 
In the example shown below the Complaints Paragraphs category has been 
expanded and the Complaints item has been selected.  Observe that the item 
type is shown in brackets after the item's name, in this case Complaints is a 
(select) item type. 
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The bottom part of this window indicates that the Complaints item is not used in 
any report templates. 
 

 
 

Complaints Paragraphs category expanded. 

 

Report Item Editor Buttons 
 

 
Click this button to create a new item.  See the topic, 
"Creating New Items" for more detailed information. 
 

 
Click this button to open an edit mode window for the 
currently selected item.  See the topic, "Editing Items" for 
more detailed information. 
 

 
Click this button to delete the item from the system.  Note 
that this will remove the item from all Templates and 
Narrative Items that it is used in. 
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Click this button to close the Report Item Editor. 

 
 

Factory Default Items 

Listed in the tables below are the factory default report items, their 
corresponding item type, function, and the report template or narrative item they 
are used in.  Systems purchased prior to May 2008 may have a slightly different 
list. 
 

 Not all items listed are used in a report template or narrative item, 
this is indicated by the dashed lines (----) in the "Used In" field.  These 
items are available to insert into new or existing templates. 

 

 
 

Item Name Item Type Function 

 
Used In 

Anatomy 
Graphic 
(Muscles) 

Sierra Used to insert the AnatomyVIEW 
Muscle Data graphic into the report. 

Full Report with 
SG and AV. 

Anatomy 
Graphic 
(Nerves) 

Sierra Used to insert the AnatomyVIEW 
Nerve Data graphic into the report. 

Full Report with 
SG and AV. 

Anatomy 
View Key 
(ALL) 

Insert Used to insert the normal/abnormal 
keys into the report. 

Full Report with 
SG and AV. 

Anatomy 
View Key 
(Muscles) 

Insert Used to insert only the 
normal/abnormal key for muscle data 
into the report. 

---- 

Anatomy 
View Key 
(Nerves) 

Insert Used to insert only the 
normal/abnormal key for nerve data 
into the report. 

---- 

Anatomy 
View Label 

Paragraph Can be used to insert the text 
"Anatomy View" into the report. 

Full Report with 
SG and AV. 
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Item Name Item Type Function 

 
Used In 

Chief 
Complaints 

Select Used to create a sentence describing 
the patient's complaints. 

---- 

Complaints: Select Used to create a sentence describing 
the patient's complaints. 

Assigned to 
Custom Field #1 
in patient 
information 
window. 

Motor 
Vehicle 
Accident 

Paragraph Can be used to create a sentence 
describing when MVA occurred and 
what are presenting complaints. 

---- 

 

 

 
 

Item Name Item Type Function 

 
Used In 

Allergic to Paragraph Used to document patient allergies. Patient History / 
Exam Narrative 

Functional 
history 

Paragraph Used to document patient's 
occupation and dependence. 

Patient History / 
Exam Narrative 

Manual 
muscle 
testing 

Paragraph Used to document muscle strength Patient History / 
Exam Narrative 

Muscle 
stretch 
reflexes 

Paragraph Used to document muscle reflexes. Patient History / 
Exam Narrative 

No allergies Paragraph Used to document no patient allergies. Patient History / 
Exam Narrative 

No 
Medications 

Paragraph Used to document that no medications 
are currently being taken. 

Medications: 
Narrative 
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No 
Significant 
Past 
Medical 
History 

Paragraph Used to document no significant past 
medical history. 

Patient History / 
Exam Narrative 

No Surgical 
History 

Paragraph Used to document no past surgical 
history. 

Patient History / 
Exam Narrative 

Past 
Medical 
History 
significant 
for 

Paragraph Used to document significant past 
medical history. 

Patient History / 
Exam Narrative 

Positive 
Surgical 
History 

Paragraph Used to document patient's past 
surgical history. 

Patient History / 
Exam Narrative 

Provocative 
testing 

Paragraph Used to document results of 
provocative testing, like Tinel's sign. 

Patient History / 
Exam Narrative 

Sensation Paragraph Used to document sensation testing. Patient History / 
Exam Narrative 

Taking 
Medication 

Paragraph Used to document patient's current 
medications. 

Medications: 
Narrative 
 

 
 

 
 

Item Name Item Type Function 
 

Used In 

Abn EMG Paragraph Used to describe abnormal EMG 
findings as neuropathic or myopathic. 

EMG/NCV 
Findings 
Narrative 

Abn Motor Paragraph Used to create sentences describing 
motor nerve conduction results. 

EMG/NCV 
Findings 
Narrative 

Abn 
Sensory 

Paragraph Used to create sentences describing 
sensory nerve conduction results. 

EMG/NCV 
Findings 
Narrative 

All other 
nerves 
normal. 

Paragraph Used to enter the sentence, "All other 
nerves tested were within normal 
limits". 

EMG/NCV 
Findings 
Narrative 
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F Waves Paragraph Used to create a sentence describing F 

Wave test results. 
EMG/NCV 
Findings 
Narrative 

H Reflex Paragraph Used to create a sentence describing H 
Reflex test results. 

EMG/NCV 
Findings 
Narrative 

Normal 
EMG 

Paragraph Used to create a sentence describing 
EMG results as normal in the selected 
upper/lower  extremities. 

EMG/NCV 
Findings 
Narrative 

Normal 
LOW NCV 

Paragraph Used to create a sentence describing 
NCV results as normal in the lower 
extremities. 

EMG/NCV 
Findings 
Narrative 

Normal UP 
NCV 

Paragraph Used to create a sentence describing 
NCV results as normal in the upper 
extremities. 

EMG/NCV 
Findings 
Narrative 

 
 

 
 

Item Name Item 
Type 

Function 

 
Used In 

Abn Motor 
Selections 

Select Same function as the Abn Motor 
paragraph item but implemented using a 
select item type.  

---- 

Abn Sensory 
Selections 

Select Same function as the Abn Sensory 
paragraph item but implemented using a 
select item type.  

---- 

F Wave 
Selections 

Select Same function as the F Wave paragraph 
item but implemented using a select 
item type.  

---- 
 

 
 

 
 

Item Name Item Type Function 
 

Used In 

Carpal Tunnel Paragraph Used to create an impression 
sentence indicating Carpal Tunnel. 

Impression: 
Narrative 
 

No Evidence 
of other... 

Select Used to document that no other 
abnormalities were found. 

Impression: 
Narrative 
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Normal Study Paragraph Used to create an impression 

sentence indicating a Normal Study. 
Impression: 
Narrative 
 

Peripheral 
Neuropathy 

Paragraph Used to create an impression 
sentence indicating Peripheral 
Neuropathy. 

Impression: 
Narrative 
 

Radiculopathy Paragraph Used to create an impression 
sentence indicating Radiculopathy. 

Impression: 
Narrative 
 

 
 

 
 

Item Name Item Type Function 
 

Used In 

EMG & NCV 
Findings 
Label 

Paragraph Used to insert the text "EMG & NCV 
Findings:" into the report. 

Full Report with 
DataLAB, Full 
Report with 
Sentence Gen, 
Full Report with 
SG and AV. 

EMG 
Findings 
Label 

Paragraph Can be used to insert the text "EMG 
Findings:" into the report. 

----- 

EP Findings 
Label 

Paragraph Can be used to insert the text "EP 
Findings:" into the report. 

----- 

F Wave 
Findings 
Label 

Paragraph Can be used to insert the text "F Wave 
Findings" into the report. 

----- 

H Reflex 
Findings 
Label 

Paragraph Can be used to insert the text "H Reflex 
Findings" into the report. 

----- 

NCV 
Findings 
Label 

Paragraph Can be used to insert the text "NCV 
Findings:" into the report. 

----- 

NCV 
Waveforms 
Label 

Paragraph Can be used to insert the text "NCV 
Waveforms:" into the report. 

----- 
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Waveforms 
Label 

Paragraph Used to insert the text "Waveforms:" 
into the report 

Full Report 
(manual 
Findings), Full 
Report with 
Sentence Gen, 
Full Report with 
DataLAB, Full 
Report with SG 
and AV, MMUA 
Report, 
TabData 
w/Traces. 

 
 

 
 

Item Name Item 
Type 

Function 
 

Used In 

EMG/NCV 
Findings 

Narrative Used to create the EMG and NCV 
Findings section of the report. 

Full Report 
(manual 
Findings) 
template 

Impression: Narrative Used to create the Impression 
section of the report. 

Assigned to 
Custom Field 
#4 in patient 
information 
window. 

Medications: Narrative Used to create the Medications 
section of the report. 

Assigned to 
Custom Field 
#2 in the 
patient 
information 
window. 

Patient History 
/Exam: 

Narrative Used to create the Patient History / 
Exam section of the report. 

Assigned to 
Custom Field 
#3 in the 
patient 
information 
window. 

Recommendations Narrative Used to create the 
Recommendations section of the 
report. 

Assigned to 
Custom Field 
#5 in the 
patient 
information 
window. 

 
 



Report Item Editor 

67 

 
 

Item Name Item Type Function 
 

Used In 

Age Paragraph Can be used to enter the patient's age. ----- 

Birthdate Paragraph Can be used to enter the patient's 
birthdate. 

----- 

Custom 
Field 1 

Paragraph Used to insert the contents of Custom 
Field #1 found in the Patient 
Information window into the report.  By 
default this is the Chief Complaints. 

All default 
templates 

Custom 
Field 10 

Paragraph Can be used to insert the contents of 
Custom Field #10 from the Patient 
Information window. 

----- 

Custom 
Field 2 

Paragraph Used to insert the contents of Custom 
Field #2 from the Patient Information 
window. By default this is the 
Medications. 

All default 
templates 

Custom 
Field 3 

Paragraph Used to insert the contents of Custom 
Field #3 from the Patient Information 
window.  By default this is the Patient 
History / Exam  

All default 
templates 

Custom 
Field 4 

Paragraph Used to insert the contents of Custom 
Field #4 from the Patient Information 
window.  By default this is the 
Impressions. 

All default 
templates 

Custom 
Field 5 

Paragraph Can be used to insert the contents of 
Custom Field #5 from the Patient 
Information window. 

----- 

Custom 
Field 6 

Paragraph Can be used to insert the contents of 
Custom Field #6 from the Patient 
Information window. 

----- 
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Custom 
Field 7 

Paragraph Can be used to insert the contents of 
Custom Field #7 from the Patient 
Information window into the report. 

---- 

Custom 
Field 8 

Paragraph Can be used to insert the contents of 
Custom Field #8 from the Patient 
Information window into the report. 

---- 

Custom 
Field 9 

Paragraph Can be used to insert the contents of 
Custom Field #9 from the Patient 
Information window into the report. 

---- 

First Name Paragraph Can be used to enter the patient's first 
name. 

----- 

Full Name Paragraph Can be used to enter the patient's full 
name. 

----- 

Last Name Paragraph Can be used to enter the patient's last 
name. 

----- 

Middle 
Name 

Paragraph Can be used to enter the patient's 
middle name. 

----- 

Patient 
Block 

Table Used to insert a table containing the 
patient's name, height, weight, sex, id, 
and date of birth.  Also the physician, 
ref. physician, and technician names. 

All default 
templates 

Patient 
Block 2 

Table Can be used to insert a table like 
Patient Block above but without height, 
weight, or technician name. 

----- 

Patient ID Paragraph Can be used to enter the patient's ID#. ----- 

Sex Paragraph Can be used to enter the patient's sex. ----- 

 
 

 
 

Item Name Item Type Function 
 

Used In 

Continue current 
management 

Paragraph Used to recommend that 
patient continues current 
treatment. 

Recommendation: 
Narrative 

Continue use of 
splint 

Paragraph Used to recommend continued 
use of splint. 

Recommendation: 
Narrative 

Follow-up with 
Ref. Physician 

Paragraph Used to recommend that 
patient follow-up with referring 
physician. 

Recommendation: 
Narrative 

Recommendations Paragraph Used to create a sentence for 
recommendations. 

----- 

Repeat Studies Paragraph Used to recommend that 
studies be repeated on the 
patient. 

Recommendation: 
Narrative 
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Suggest MRI and 
Surgical eval 

Paragraph Used to recommend that 
patient receive MRI and 
surgical evaluation. 

Recommendation: 
 Narrative 

Suggest surgical 
evaluation 

Paragraph Used to recommend that 
patient receive a surgical 
evaluation. 

Recommendation: 
Narrative 

 
 

 
 

Item Name Item 
Type 

Function 

 
Used In 

Insert 
ReportHeader.doc 

Insert - 
Document 

Used to insert the contents of a file 
called "Report Header.doc" into the 
report at the top of the first page. 
 This file is located in the 
C:\Cadwell\Sierra Wave folder. 

All default 
templates 

 
 

 
 

Item Name Item Type Function 

 
Used In 

EMG 
Sentence 

Paragraph Can be used to insert the EMG 
Sentence Generator results into a 
narrative item. 

----- 

EMG 
Sentence 
Gen 

Sierra Used to insert both the EMG 
Sentence Generator results into the 
report. 

Full Report with 
DataLAB, Full 
Report with 
Sentence Gen, 
and Full Report 
with SG and AV. 

 
EMG/NCV 
 Sentence 

Paragraph Can be used to insert the EMG and 
NCV Sentence Generator results into 
a narrative item. 

----- 

EMG/NCV 
 Sentence 
Gen 

Sierra Used to insert both the EMG and NCV 
Sentence Generator results into the 
report. 

----- 
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EP Sentence 
Gen (ALL) 

Sierra Can be used to insert the EP 
Sentence Generator results (All EP 
tests) into the report. 

----- 

EP Sentence 
Gen (Current 
Test) 

Sierra Can be used to insert the EP 
Sentence Generator results (only for 
the currently selected EP test) into the 
report. 

----- 

F Wave 
Sentence 
Gen 

Sierra Can be used to insert the F Wave 
Sentence Generator results into the 
report. 

----- 

H Reflex 
Sentence 
Gen 

Sierra Can be used to insert the H Reflex 
Sentence Generator results into the 
report. 

----- 

NCV 
Sentence 
Gen 

Sierra Can be used to insert the NCV/F/H 
Sentence Generator results into a 
report. 

----- 

NCV/F/H 
Sentence 

Paragraph Can be used to insert the EMG and 
NCV/F/H Sentence Generator results 
into a narrative item. 

----- 

NCV/F/H 
Sentence 
Gen 

Sierra Used to insert the EMG and NCV/F/H 
Sentence Generator results into the 
report. 

Full Report with 
DataLAB, Full 
Report with 
Sentence Gen, 
and Full Report 
with SG and AV. 
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Item Name Item 

Type 
Function 

 
Used In 

AEP Amp 
History 

Sierra Can be used to insert only the amplifier 
settings for the AEP test protocol. 

----- 

AEP Tables Sierra Can be used to insert only the AEP 
section of the TabData tables. 

----- 

All Tables Sierra Used to insert all the TabData tables for 
the patient. 

TabData 
w/Traces, 
TabData w/o 
Traces, Full 
Report (manual 
Findings), Full 
Report with 
Sentence Gen, 
Full Report with 
SG and AV, Full 
Report with 
DataLAB. 

Blink Tables Sierra Can be used to insert only the Blink 
section of the TabData tables. 

----- 

DataLAB 
Tables 

 

Sierra Can be used to insert the summary table 
of all DataLAB results. 

Full Report with 
DataLAB 

EMG Tables Sierra Can be used to insert only the EMG 
section of the TabData tables. 

----- 

F Wave 
Tables 

Sierra Can be used to insert only the F Wave 
section of the TabData tables. 

----- 

H Reflex 
Tables 

Sierra Can be used to insert only the H Reflex 
section of the TabData tables. 

----- 

Macro EMG 
Tables 

Sierra Can be used to insert only the Macro 
EMG section of the TabData tables. 

----- 

Markers Sierra Used to insert the Time & Amplitude 
marker information for the current test. 

Current Test 

MMUA 
Tables 

Sierra Can be used to insert the MMUA 
summary table. 

MMUA Report 

NCV L/R Diff 
Tables 

Sierra Used to insert the NCV Left vs. Right 
difference tables. 

TabData 
w/Traces, 
TabData w/o 
Traces, Full 
Report, Full 
Report with 
Sentence Gen. 

NCV Tables Sierra Can be used to insert only the NCV 
section of the TabData tables. 

----- 

P300 Tables Sierra Can be used to insert only the P300 
section of the TabData tables. 

----- 
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Real Time 
SFEMG 
Summary 
Only 

Sierra Can be used to insert only the summary 
statistics from the Real Time SFEMG 
test protocol. 

----- 

Real Time 
SFEMG 
Tables 

Sierra Can be used to insert only the Real 
Time SFEMG section of the TabData 
tables. 

----- 

Results Sierra Used to insert the auto-cursor table for 
the current test. 

Current Test 

 

RNS Tables Sierra Can be used to insert only the RNS 
section of the TabData tables. 

----- 

SEP Lower 
Tables 

Sierra Can be used to insert only the SEP 
Lower section of the TabData tables. 
 This includes all types of SEP Lower 
test results. 

----- 

SEP Upper 
Tables 

Sierra Can be used to insert only the SEP 
Upper section of the TabData tables. 
 This includes all types of SEP Upper 
test results. 

----- 

SFEMG 
Tables 

Sierra Can be used to insert only the SFEMG 
section of the TabData tables. 

----- 

SSFEMG 
Tables 

Sierra Can be used to insert only the 
Stimulated - SFEMG section of the 
TabData tables. 

----- 

Stim History 
(All Tables) 

Sierra Can be used to insert stimulus history 
tables for all EP test protocols in the 
data file. 

 

Stim History 
(Current 
Test) 

Sierra Used to insert a table of stimulus 
parameters, gain, and filter settings for 
the current test. 

Current Test 

VEP Tables Sierra Can be used to insert only the VEP 
section of the TabData tables. 

----- 

 
 

 
 

Item Name Item Type Function 
 

Used In 

Physician Paragraph Can be used to insert the physician's 
name as entered into the Patient 
Information window. 

----- 

Ref 
Physician 

Paragraph Can be used to insert the referring 
physician's name as entered into the 
Patient Information window. 

----- 
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Technician Paragraph Can be used to insert the technician's 

name as entered into the Patient 
Information window. 

----- 

Test Date Paragraph Used to insert the test date into the 
report. 

All default 
templates 

 
 

 
 

Item Name Item 
Type 

Function 
 

Used In 

AEP Only Sierra Can be used to insert only the AEP 
traces into the report. 

----- 

All TD Waves 
(12, 16, 25, 4, 
6, 9 per 
page) 

Sierra Used to insert all the waves available 
into the report.  Number in brackets 
indicates how many waveform blocks 
per page.  9 per page is the default. 

TabData 
w/Traces, Full 
Report, Full 
Report with 
Sentence Gen. 

Blink Only Sierra Can be used to insert only the Blink 
traces into the report. 

----- 

EMG Only Sierra Can be used to insert only the EMG 
snapshot traces into the report. 

----- 

Fwave Only Sierra Can be used to insert only the F Wave 
traces into the report. 

----- 
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H Reflex 
Only 

Sierra Can be used to insert only the H Reflex 
traces into the report. 

----- 

Macro EMG 
Only 

Sierra Can be used to insert only the Macro 
EMG traces into the report. 

----- 

MMUA Only Sierra Can be used to insert only the MMUA 
summary traces into the report. 

MMUA Report 

NCV Only Sierra Can be used to insert only the NCV 
traces into the report. 

----- 

P300 Only  Can be used to insert only the P300 
traces into the report. 

---- 

RNS Only Sierra Can be used to insert only the RNS 
traces into the report. 

----- 

SEP Lower 
Only 

Sierra Can be used to insert only the SEP 
Lower traces into the report.  This 
includes all types of SEP Lower traces. 

----- 

SEP Upper 
Only 

Sierra Can be used to insert only the SEP 
Upper traces into the report.  This 
includes all types of SEP Upper traces. 

----- 

SFEMG Only Sierra Can be used to insert only the SFEMG 
traces into the report. 

----- 

SSFEMG 
Only 

Sierra Can be used to insert only the 
Stimulated SFEMG traces into the 
report. 

----- 

VEP Only Sierra Can be used to insert only the VEP 
traces into the report. 

----- 

Waves for 
Current Test 
(Lg, Med, 
Sml, xSml) 

Sierra Can be used to insert the traces for the 
currently selected EP test.  Default size 
is Medium. 

 
Current Test 

 
 

 
 

Item Name Item Type Function 
 

Used In 

Signature Paragraph Can be used to insert a signature line 
and single physician name.  Must enter 
physician's name into the item before 
using.. 

----- 

Signature 
By Choice 

Paragraph Can be used to insert a signature line 
and also select from a list of physician 
names.  Must edit the physician names 
prior to using. 

----- 
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Signature 
from Patient 
Info 

Paragraph Used to insert a signature line and the 
physician's name, as entered into the 
Patient Information window. 

Full Report 
(manual 
Findings), Full 
Report with 
Sentence Gen, 
Full Report with 
DataLAB, Full 
Report with SG 
and AV. 

 
 

 
 

Item Name Item Type Function 
 

Used In 

1 Carriage 
Return 

Paragraph Used to insert one carriage return 
between items in a template. 

All default 
templates 

10pt Times 
Rt Just 

Insert - 
Style 

Used to insert a formatting style of 10 
pt, Times New Roman, Right Justified 
text. 

All default 
templates 

2 Carriage 
Returns 

Paragraph Used to insert two carriage return 
between items in a template. 

MMUA Report, 
TabData 
w/Traces. 

3 Carriage 
Returns 

Paragraph Used to insert three carriage return 
between items in a template. 

----- 

Heading 
Style 1 

Insert-
Style 

Can be used to insert the formatting 
style called "Heading Style 1" into the 
template.  (14pt, Times New Roman, 
Bold, Center Justified) 

----- 

Margins 0.5 
inches - 
Landscape 

Insert-
Margins 

Can be used to set all the page 
margins to 0.5 inches and the page 
layout to landscape format. 

----- 

Margins 0.5 
inches - 
Portrait 

Insert-
Margins 

Used to set all the page margins to 0.5 
inches and the page layout to portrait. 

All default 
templates 
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Normal 12pt 
Centered 

Insert-
Style 

Used to insert the formatting style 
called "Normal 12pt Centered" into the 
template.  (12pt, Times New Roman, 
Center Justified) 

Current Test 

Normal 
Paragraph 
12pt Times 

Insert-
Style 

Used to insert the formatting style 
called "Normal Paragraph 12pt Times" 
into the template.  (12pt, Times New 
Roman, Left Justified) 

All default 
templates 

Normal 
Paragraph2 
10pt Times 

Insert-
Style 

Used to insert the formatting style 
called "Normal Paragraph2 10pt Times" 
into the template.  (10pt, Times New 
Roman, Left Justified) 

All default 
templates 

Page Break Insert-
Page 
Break 

Used to insert a manual page break 
between items in a template. 

Full Report 
(manual 
Findings, Full 
Report with 
Sentence Gen, 
Full Report with 
DataLAB, Full 
Report with SG 
and AV. 

Page Footer Insert-
Page 
Footer 

Can be used to insert a page footer at 
the bottom of all pages of the report 
(except the first page). 

----- 

Page 
Header 

Insert-
Page 
Header 

Used to insert a page header at the top 
of all pages of the report (except the 
first page). 

All default 
templates 

Table 
Format - 9pt 
Times 

Insert-
Style 

Used to insert the formatting style 
called "Table Format 9pt Times" into 
the template.  (9pt, Times New Roman, 
Left Justified) 

All default 
templates 

Table 
Format2 - 
9pt Arial 

Insert-
Style 

Can be used to insert the formatting 
style called "Table Format2 9pt Arial" 
into the template.  (9pt Arial, Left 
Justified) 

----- 

Todays 
Date 

Paragraph Can be used to insert the current date 
into the report. 

----- 
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Editing Items 

Open the Report Item Editor 
 

From Within the Sierra Wave program: 
 

 Select Launch QuickReport and Select Template from the File 
menu. 

 
From the Windows Desktop: 
 

 Double click the QuickReport icon. 
 
After the QuickReport window is displayed, select Edit Items from the File menu. 
 The Report Item Editor will be displayed. 
 

 
 

Report Item Editor window. 
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Item categories are indicated by this icon .  Click the plus sign (+) in front of a 
category name to view the individual items that are stored within that category. 
 
Select an item by clicking on the item's name.  Click the Edit Item button to 
open an edit mode window. 
 
After all edits have been made, click the Update button to save your changes. 
 All places where this item is used (in Templates and/or Narrative Items) will be 
automatically updated with the changes. 
 
Close the Report Item Editor by clicking the Done button. 
 
 

 Create New Copy check box:  Use this box to create a copy of an existing 
item.  The program will automatically change the Label and ID# for the item. 
 After checking this box, click the Add button. 
 

Deleting Items 

Open the Report Item Editor 
 

From Within the Sierra Wave program: 
 

 Select Launch QuickReport and Select Template from the File 
menu. 

 
From the Windows Desktop: 
 

 Double click the QuickReport icon. 
 
After the QuickReport window is displayed, select Edit Items from the File menu. 
 The Report Item Editor will be displayed. 
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Report Item Editor window. 

 
 

Item categories are indicated by this icon .  Click the plus sign (+) in front of a 
category name to view the individual items that are stored within that category. 
 
Select an item by clicking on the item's name.  Click the Delete Item button. 
 Answer YES to the following message. 
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The item will be deleted from all the Templates and/or Narrative Items it was 
used in.  Close the Report Item Editor by clicking the Done button. 

Creating a New Paragraph Item 

To Create a New Paragraph Item 
 

1. From the Select Report View, select Edit Items from the File menu.  The 
Report Item Editor will be displayed. 

 

 
 

Report Item Editor window. 

 
2. Click the Create New button.  The Create New Report Item window will be 

displayed. 
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3. Select the Paragraph Item Type, a graphic appears to the right illustrating 

the type of item that is selected.  Now select a Report Item Category from 
the drop down list.  You can use an existing category or you can create a 
new category by typing the category name into the selection box. 

 
4. Click OK 
 
5. A blank Paragraph item window is displayed.  This window defaults with one 

text and one choice box already inserted. 
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Blank Paragraph item window. 

 
6. Enter a Label for the new paragraph item, this is the label that will appear in 

the Report Item Editor. 
 
7. Working with Text, Choice, and Select boxes. 

Text Boxes: 
Click the mouse within the text box and then enter text by typing.  In the 
example below, the text "NCV studies revealed" has been entered. 
 

 
 

 If a choice box will follow the text box, a blank space 
is not required after the last word in the text box. 
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Choice Boxes: 
Click the mouse after the green arrow in the choice box.  Type the first 
choice then press the Enter key.  A new arrow will appear.  Continue in 
this fashion until all choices have been entered.  The following example 
has choices for normal vs. abnormal latency, amplitude and velocity. 
 

 
 

Allow Multiple check box - when this box is checked the user will be 
able to select more than one choice within the box during report 
generation.  The program will automatically place the word "and" 
between two choices as well as a comma "," when more than two 
choices are made. 
 
Required check box (optional) - when this box is checked a yellow 
notification message will be displayed during report generation.  This 
tells the user that something within this choice box must be selected in 
order to make the item complete. 
 

Inserting additional Text and Choice Boxes: 
First, click on one of the existing boxes to select it.  A small blue line will 
be drawn around the box to illustrate that it is selected.  Now, click on the 
Add Text Box or Add Choice Box buttons.  The additional box is 
inserted below the selected box.  In the example below the choice box has 
been selected and a new text box has been added below it.  The text, "in 
the", has been typed into the second text box. 
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 When a text box is used after a choice box, be sure to start 
the text with a blank space. 

 
Inserting a Select Box: 
First, click on one of the existing boxes to select it.  A small blue line will 
be drawn around the box to illustrate that it is selected.  Now, click on the 
Add Select Box button.  The new Select box is inserted below the box 
that was outlined in blue.  Type your first selection into the blank box and 
then press Enter.  Another blank box is displayed, continue in this manner 
until you have input all your selections. 
 

 
 

Unlike a choice box, the select box requires that you enter 
words like "and", "are", "is", and comma's into your selection list. 

 
The following example shows a select box that allows various 
combinations of side and nerve to be selected.  A final choice box has 
also been added to allow a single choice to finish the sentence. 
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One possible sentence that could be formed using this paragraph item 
would be, "NCV studies revealed normal latency, normal amplitude, and 
normal conduction velocity in the left and right median motor nerves". 
 
Changing the order of boxes and Removing boxes: 
To change the order of the boxes, left click on the edge of a box and 
move the mouse up or down within the item.  Release the mouse where 
you would like the box to be placed. 
 
To remove a box, right click on the edge of a box and select "Cut" from 
the pop-up menu. 
 

 
 
 

8. Add Tokens and Formatting Tags  (Optional) 
 
Add special commands called Tokens, to insert Patient or Test Information. 
 Use Formatting Tags to bold, underline, or italicize words within the item. 
 
In the example shown below the patient's name has been added to the initial 
text box using Tokens (note the <DATA "PATIENT.FIRSTNAME"/> and 
<DATA PATIENT.LASTNAME"/> tokens). 
 

 
 

In the following example, bolding has been initiated before the patient's name 
and turned off after the patient's name using Formatting Tags (note the <B> 
and the </B> tags). 
 

 
 
For more information on using Tokens and Formatting Tags, see the 
following topics. 
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Using Tokens (Patient & Test Information) 
 
Using Formatting Tags. 

 
 

9. Click the Add button in the lower right hand corner. 
 

The new Paragraph item will be saved. 
 
 

To insert the newly created Paragraph item into a template, see the following 
topic. 
 

Inserting Items into a Template. 

Creating a New Insert Item 

To Create a New Insert Item 
 

1. From the Select Report View, select Edit Items from the File menu.  The 
Report Item Editor will be displayed. 
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Report Item Editor window. 

 
2. Click the Create New button.  The Create New Report Item window will be 

displayed. 
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3. Select the Insert Item Type, a graphic appears to the right illustrating the 

type of item that is selected.  Now select a Report Item Category from the 
drop down list.  You can use an existing category or you can create a new 
category by typing the category name into the selection box. 

 
4. Click OK 
 
5. A blank Insert item window is displayed.  This window defaults with the 

Page Break type selected. 
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6. Enter a Label for the new insert item, this is the label that will appear in the 

Report Item Editor. 
 
7. Select the Type of item to be inserted.  Choices are Page Break, Style, 

Picture, Document, Margins, Header, Footer, and Tab Stops. 
 

Page Break: 
To create an item that allows you to insert a manual page break between 
other items in the report, select the Page Break type. 
 
Style: 
To create an item that allows you to change the formatting style within the 
report, select the Style type.  Click the Browse or Edit button to view the 
Quick Report Style Editor. 
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Quick Report Style Editor 
 

Clicking the Browse button allows you to choose any of the 20 listed 
styles.  Clicking the Edit allows you to change the settings for the User 
Styles 1-10. 
 
The following settings can be changed for User Styles 1-10:   

Style name, Description, Font (size, name, color, bold, italics, 
underline), Paragraph alignment and spacing, and the Paragraph 
indentation. 

 

 You should click the Edit button first, make sure the 
style you need is available, if not, make the necessary 
changes and click the Save button.  Then click the Browse 
button to assign the style. 

 
Picture: 
To create an item that inserts a picture into the report, select the Picture 
type.  Click the Browse button to display a standard Window's Open 
dialog and browse to any location on the computer to choose a BMP, 
JPG, or GIF picture file. 
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Document: 
To create an item that inserts the contents of another document into the 
report, select the Document type.  Click the Browse button to display a 
standard Window's Open dialog and browse to any location on the 
computer to choose a DOC, DOCX, DOT, DOTM, RTF, XML or TXT 
document file. 
 

 The report header is inserted at the top of the report using an 
Insert - Document item. 

 
Margins: 
To create an item that allows you to change the margins and page layout 
of the report, select the Margins type.  Use the up/down arrow buttons to 
change the Left, Right, Top & Bottom margins and select either Portrait or 
Landscape for the page layout. 
 
Header or Footer: 
To create an item that inserts information at the top or bottom of all pages 
in the report, select the Header or Footer type respectively.  Use the large 
text box to input the information you want included in the header or footer. 

 You can simply type text into this box, you can use Tokens , and you 

can use Formatting Tags .  Select the alignment for the information 
and indicate if the first page of the report should be excluded (i.e., 
skipped). 
 

 
 
Tab Stops: 
To create an item that allows the tab stops settings in the report to be 
changed (the default is 0.5 inches), select the Tab Stop type.  Use the 
up/down arrow buttons to change the setting. 
 

8. Click the Add button in the lower right hand corner. 
 

The new Insert item will be saved. 
 
 

To insert the newly created Insert item into a template, see the following 
topic. 
 

Inserting Items into a Template. 
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Creating a New Sierra Item 

To Create a New Sierra Item. 
 

1. From the Select Report View, select Edit Items from the File menu.  The 
Report Item Editor will be displayed. 

 

 
 

Report Item Editor window. 

 
2. Click the Create New button.  The Create New Report Item window will be 

displayed. 
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3. Select the Sierra Item Type, a graphic appears to the right illustrating the 

type of item that is selected.  Now select a Report Item Category from the 
drop down list.  You can use an existing category or you can create a new 
category by typing the category name into the selection box. 

 
4. Click OK 
 
5. A Sierra item window is displayed.  The value defaults to TabData, available 

tests to All. 
 

 
 

6. Enter a Label for the new sierra item, this is the label that will appear in the 
Report Item Editor. 
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7. Select the Sierra Value and Available Tests (if applicable).  Use the 

following table as a guide. 
 

Sierra Value Available 
Tests 

Function 

Markers* Not applicable. Inserts a table showing the values 
for the Time and Amplitude 
markers in the current test only. 

Results* Not applicable. Inserts a table of auto-cursor 
values for the current test only. 

Stim History* Not applicable. Inserts a table showing the stimulus 
parameters, display gain, hicut, 
locut, and sweep speed for each 
trial/trace in the current test only. 

Stim History 
(All EP Tests) 

Not Applicable. Inserts a stimulus history table for 
every EP test protocol in the data 
file. 

AEP Amp 
History 

Not Applicable. Inserts a table showing the 
amplifier settings for the AEP test 
protocol. 

TabData All, AEP, Blink, 
EMG, F-Wave, H-
Reflex, NCV, RNS, 
SEP Lower, SEP 
Upper, SFEMG, 
SSFEMG, VEP, 
P300, MUNE-Incr, 
MUNE-MPS, RR 
Interval, Real-time 
SFEMG, Macro 
EMG, and EMG 
Guidance. 

Inserts summary tables for all the 
tests performed on the patient (All) 
or for a selected test. 

TabData Waves All, AEP, Blink, 
EMG, F-Wave, H-
Reflex, NCV, RNS, 
SEP Lower, SEP 
Upper, SFEMG, 
SSFEMG, VEP, 
P300, MUNE-Incr, 
MUNE-MPS, RR 
Interval, Real-time 
SFEMG, Macro 
EMG, and EMG 
Guidance. 

Inserts trace graphics for all the 
tests performed on the patient (All) 
or for a selected test. 

Waves* Not applicable. Inserts the trace graphics for the 
current test only. 
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NCV Sentence Not applicable. Inserts the results of the NCV 
sentence generator from the 
TabData window. 

EMG Sentence Not applicable. Inserts the results of the EMG 
sentence generator from the 
TabData window. 

NCV and EMG 
Sentence 

Not applicable. Inserts the results of both the 
NCV/F/H and EMG  sentence 
generator from the TabData 
window. 

NCV/F/H 
Sentences 

Not applicable Inserts the results of the NCV, F, 
and H sentence generator from the 
TabData window. 

F Wave 
Sentence 

Not applicable Inserts the results of the F Wave 
sentence generator from the 
TabData window. 

H-Reflex 
Sentence 

Not applicable Inserts the results of the H-Reflex 
sentence generator from the 
TabData window. 

EP Sentence Not applicable. Inserts the results of the EP 
sentence generator (All EP Tests) 
from the TabData window. 

EP Sentence 
for Current Test 

Not applicable. Inserts the results of the EP 
sentence generator (currently 
selected EP test only) from the 
TabData window. 

TabData L/R 
Diff 

NCV Inserts summary tables for the NCV 
Left vs. Right side difference 
measurements. 

DataLAB Table Not applicable. Inserts a summary table showing 
all DataLAB results for the patient. 

AnatomyVIEW 
Muscles 

Not applicable. Inserts the AnatomyView Muscle 
Data graphic for the patient. 

AnatomyVIEW 
Nerves 

Not applicable. Inserts the AnatomyView Nerve 
Data graphic for the patient. 

MMUA Table Not applicable. Inserts the MMUA results table for 
the patient. 

MMUA Waves Not applicable. Inserts a summary of the MMUA 
traces for the patient. 

Real Time 
SFEMG 
Summary 

Not applicable. Inserts a table containing only the 
summary information from the Real 
Time SFEMG test protocol. 
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* These items are only used in the default factory report template, 
"Current Test". 
 
If the TabData-NCV, TabData Waves-NCV, or TabData L/R Diff values are 
chosen you can further specify the report order for the NCV tables or waves 
using the nerve type list.  Simply click and drag the nerve types to reorder the 
list.  In the example that follows, the NCV tables will be ordered Anti Sensory 
first, Ortho Sensory second, Motor third,  Inching fourth, and Comparison last. 
 

 
Sierra Item - TabData NCV tables. 

 

8. Click OK. 
 

The new Sierra item will be saved. 
 
 

To insert the newly created Sierra item into a template, see the following 
topic. 
 

Inserting Items into a Template. 

Creating a New Select Item 

To Create a New Select Item. 
 

1. From the Select Report View, select Edit Items from the File menu.  The 
Report Item Editor will be displayed. 
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Report Item Editor window. 

 
2. Click the Create New button.  The Create New Report Item window will be 

displayed. 
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3. Select the Select Item Type, a graphic appears to the right illustrating the 

type of item that is selected.  Now select a Report Item Category from the 
drop down list.  You can use an existing category or you can create a new 
category by typing the category name into the selection box. 

 
4. Click OK 
 
5. A blank Select item window is displayed. 
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6. Enter a Label for the new select item, this is the label that will appear in the 
Report Item Editor. 

 
7. Click inside the Initial Sentence box and type the beginning of the sentence. 

 Use the Token button to insert Patient or Test Information.  Use the 

Formatting Tag button to apply bold, italic, or underline formatting to 
parts of the sentence. 

 

Use the Alphabetize button to automatically sort the list 
alphabetically. 

 
In the following example the sentence box begins with a heading called "Chief 
Complaints:" which is bracketed by the formatting tags for Bold (<B>) and 
Bold Off (</B>).  The sentence begins on the next line down with, "Patient is a 
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", and then the Token for the patient's age is inserted.  The sentence 
continues with, "-old ", then the Token for the patient's gender is inserted. 
 The sentence ends with, "who presents with". 

 

 
 
8. Use the New Word box to type in words or short phrases and then click the 

Add button (within the Word List section) to add them to the selection list. 
 Use the arrow buttons to change the order of the selections.  Use the 
Delete button to remove a selection from the list. 

 
Here is an example of a completed selection list. 
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9. Enter a Normal Sentence (optional).  In this example you could input "The 

patient presents with no complaints".  During report generation you can 
simply insert the normal sentence by clicking on the Normal button for this 
item. 

 
10. Click the Add button in the lower right hand corner. 
 

The new Select item will be saved. 
 
 

To insert the newly created Select item into a template, see the following 
topic. 
 

Inserting Items into a Template. 
 
 
 

Creating a New Narrative Item 

To Create a New Narrative Item. 
 

1. From the Select Report View, select Edit Items from the File menu.  The 
Report Item Editor will be displayed. 
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Report Item Editor window. 

 
2. Click the Create New button.  The Create New Report Item window will be 

displayed. 
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3. Select the Narrative Item Type, a graphic appears to the right illustrating the 

type of item that is selected.  Now select a Report Item Category from the 
drop down list.  You can use an existing category or you can create a new 
category by typing the category name into the selection box. 

 
4. Click OK 
 
5. A blank Narrative item window is displayed. 
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Blank Narrative Item 

 
6. Enter a Label for the new narrative item, this is the label that will appear in 

the Report Item Editor.  Enter an optional Description for the item.  As an 
example, suppose you will be creating a Narrative that will be a collection of 
all the individual Paragraph items that could be used for EMG and NCV 
findings.  The label for the narrative could be "EMG & NCV Findings" and the 
description could be "Narrative used to create EMG & NCV findings for 
report". 

 

Narrative Label and Description 

7. Add items to the Item List. 

Click on the Add button within the Item List section.  The Add Items window 
will be displayed.  Narratives can only contain Paragraph, Select, Insert, and 



Report Item Editor 

105 

Multi item types, therefore the Add Items window will be filtered and will only 
list these types of items. 

 

Filtered Item list 

Locate the item you want by expanding the appropriate Item Category.  This 
is done by clicking on the plus sign (+) in front of the category.  Clicking on 
the minus sign (-) will contract the category. 
 
Click the box in front of the Item's Label to place a check mark in it.  The 
name in brackets indicates the item's type. 
 
Click the Add button.  The selected item will be inserted into the Narrative. 
 
In the example shown below, all of the Findings Paragraphs items have 
been added to the Narrative. 
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Narrative with items added. 

 
Create New button - clicking this button will allow you to create a new 
Paragraph, Select, or Multi item. 
 
Edit button - clicking this button will allow you to edit the currently 
highlighted item in the narrative list. 
 
Delete button - clicking this button will remove the currently highlighted 
item from the narrative list. 

 
 

8. Indicate which items are Normal defaults. (optional) 
 

Right click on each item, a pop-up menu is displayed with the same button 
functions mentioned in Step #7 as well as a feature called "Has Normal 
Value". 
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Right click menu 

 
If an item has a check mark in front of "Has Normal Value", the item can be 
selected automatically during report generation by simply clicking on the 
Normal button for this Narrative item.  So, if you typically always choose the 
same items for a normal finding, this will save you time during report 
generation. 
 

9. Set the Display settings. 
 

 
 

Include Heading - when this box is checked a heading can be entered into 
the text box just to the right.  QuickReport will automatically bold this heading 
in the report. 
 
Heading on Separate Line - when this box is checked the results of the 
Narrative will be placed on the line below the heading rather than starting on 
the same line as the heading. 
 
List 
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 Numbers  - when this option is enabled each selected item in 
the Narrative will be numbered in the report.  This is shown in 
the example below. 

 

 
Numbered items. 

 

Bold  - when checked, the numbers will be displayed in 
bold text. 

 
MS Word Style - when checked, the format & style that is 
used for the numbers will be taken from Word's Normal 
template. 
 

 Bullets - when this option is enabled each selected item in 
the Narrative will be bulleted in the report. 

 
Bold - when checked, the bullets will be displayed in bold 
text. 
 
MS Word Style - when checked, the format & style that is 
used for the bullets will be taken from Word's Normal 
template. 

 
Show Copies - when checked, a copy of selected items is shown in the 
Narrative list.  This allows the item to be used again so that different 
selections can be made.  When unchecked, copies of selected items are not 
shown in the Narrative list. 
 
Show Insert Date Buttons - when checked, special buttons used to insert 
the Date or Duration Range are shown within the Narrative item during report 
generation.  The default for this setting is unchecked. 
 

10. Click the Add button in the lower right hand corner. 
 
The new Narrative item will be saved. 
 

To insert the newly created Narrative item into a template, see the following 
topic. 
 

Inserting Items into a Template. 
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Creating a New Table Item 

To Create a New Table Item. 
 

1. From the Select Report View, select Edit Items from the File menu.  The 
Report Item Editor will be displayed. 

 

 
 

Report Item Editor window. 

 
2. Click the Create New button.  The Create New Report Item window will be 

displayed. 
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3. Select the Table Item Type, a graphic appears to the right illustrating the 

type of item that is selected.  Now select a Report Item Category from the 
drop down list.  You can use an existing category or you can create a new 
category by typing the category name into the selection box. 

 
4. Click OK 
 
5. A blank Table item window is displayed. 
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Blank Table item 

 

6. Enter a Label for the new table item, this is the label that will appear in the 
Report Item Editor. 

 
7. Set the Table Specifications. 
 

 
 

Number of Columns - select the number of columns for the table. 
 
Number of Rows - select the number of rows for the table. 
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Border Style - choose the border style for the table, choices are No 
Border, Boxed, Boxed Grid, Open Grid, Top/Bottom lines, and Bottom 
Line Only. 
 
Auto Fit Behavior - choose how the table will fit across the page, choices 
are Fixed Column Widths, Auto Fit to Contents, and Auto Fit to Window. 
 When the option Fixed Column Widths is selected you will be able to 
specify the width of each column in inches. 

 
A table will be created based on the chosen specifications.  If you change any 
of the specifications you will need to click the Create Table button again. 
 
The example below shows a 4 column, 2 row table with a border style of 
Top/Bottom Lines and Fixed Column widths.  To adjust the column widths, 
simply click the up/down arrows above each column. 
 

 
Table item - empty. 

 

8. Fill the cells within the Table. 
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To enter text into a cell: 
Click within the cell and type the desired text.  You can format the text by 
first highlighting the text, then right click and select Bold, Italics, or 
Underline from the pop-up menu. 
 

To enter a Token into a cell: 
Right click within the cell and select Add Token.  Select a Patient or Test 
Information token and click OK. 
 

The following example has bolded text within the cells of Columns 1 & 3 and 
patient data tokens are inserted within the cells of Columns 2 & 4.  Don't 
worry if the token doesn't fit within the cell, it will be handled appropriately 
during report generation. 
 

 
 
 
10. Click the Add button in the lower right hand corner. 

 
The new Table item will be saved. 
 
 

To insert the newly created Table item into a template, see the following 
topic. 
 

Inserting Items into a Template. 
 
 

Tokens 

The Paragraph, Select, Table, and Insert item types can contain special 
commands called "Tokens".  Tokens are used to insert Patient and Test 
Information data into the item. 
 

Tokens are entered by clicking on the token button .  This will display a 
Select Data window that allows the selection of a Source category and then a 
specific Token (called an item in the menu). 
 
Shown below is an example of the Select Data window.  The Patient category is 
selected in the left hand column and the available tokens for this category are 
listed in the right hand column.  
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Select Data (Token) window. 

 
When a token is inserted into an item it has a characteristic appearance, it begins 
with a less than symbol (<) and ends with a forward slash and a greater than 
symbol (/>).  If the token for Patient-Age is selected it will appear in the item as 
follows. 
 

<DATA "PATIENT.AGE"/> 
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Available Tokens and their Function 
 

Gender Tokens: 
These tokens insert one of the words in the selected combination, the 
word that is inserted is determined by the gender selected in the Sierra 
Wave's Patient Information window. 
 

Token Function 

he_she Inserts the word "he" or "she" into the sentence. 

him_her Inserts either the word "him" or "her" into the sentence. 

his_her  Inserts either the word "his" or "her" into the sentence. 

his_hers Inserts either the word "his" or "hers" into the sentence. 

male_female Inserts either the word "male" or "female" into the 
sentence. 

ADD NEW 
ITEM 

Click here to create additional Gender combinations. 
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Patient Tokens: 
 

Token Function 

Age (plural 
unit, e.g. 
years) 

Inserts the patient's age followed by the word 'years', 
this is computed from the birthdate. 

Age 
(singular 
unit, e.g. 
year) 

Inserts the patient's age followed by the word 'year', 
this is computed from the birthdate. 

Age (value 
only) 

Inserts the patient's age followed by no other text, this 
is computed from the birthdate. 

Birthdate Inserts the patient's birthdate. 

First Name Inserts the patient's first name. 

Full Name Inserts the patient's full name (i.e., first name & last 
name). 

Last Name Inserts the patients last name. 

Middle 
Name 

Inserts the patient's middle name or initial. 

Patient ID Inserts the patient's ID number. 

Sex Inserts the patient's sex (i.e., Male or Female). 
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Sentence Generator Tokens: 
 

Token Function 

EMG Sentence Special token that can be used within a 
Paragraph Item's text box and which inserts 
the EMG findings sentences from the TabData 
window. 

NCV and EMG 
Sentence 

Special token that can be used within a 
Paragraph Item's text box and which inserts 
the NCV/F/H & EMG findings sentences from 
the TabData window. 
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NCV Sentence Special token that can be used within a 
Paragraph Item's text box and which inserts 
the NCV findings sentences from the TabData 
window. 

 

 
 
 
Sierra Custom Field Tokens: 
 

Token Function 

Custom Field 1 - 20 Inserts the contents of the custom patient 
information fields (#'s 1-20) from the Sierra 
Wave's Patient Information window.   

Custom Field Label 
1 - 20 

Inserts the custom field labels (#'s 1-20). 
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Sierra Test Information Tokens: 
 

Token Function 

Patient Height Inserts the patient's height as entered in the Sierra 
Wave's Patient Information window. 

Patient Weight Inserts the patient's weight as entered in the Sierra 
Wave's Patient Information window. 

Physician Inserts the Physician's name as entered in the 
Sierra Wave's Patient Information window. 

Referring 
Physician 

Inserts the Referring Physician's name as entered 
in the Sierra Wave's Patient Information window. 

Technician Inserts the Technician's name as entered in the 
Sierra Wave's Patient Information window. 

Test Date & 
Time #1 

Inserts the Test Date and Test Time in the format, 
11/5/2003  8:45:00 AM. 

Test Date & 
Time #2 

Inserts the Test Date and Test Time in the format, 
Wednesday, November 5, 2003  8:45:00 AM. 
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Test Date #1 Inserts the Test Date in the format, 11/5/2003. 

Test Date #2 Inserts the Test Date in the format, Wednesday, 
November 5, 2003. 

Test Time Inserts the Test Time in the format, 8:45:00 AM 

 

 
 
 
Today's Tokens: 

 

Token Function 

Date #1 Inserts the Current Date in the format, 11/5/2003. 

Date #2 Inserts the Current Date in the format, November 5, 
2003. 

Day of Week Inserts the Current Day of the Week. 

Time Inserts the Current Time in the format, 8:45:00 AM 
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Formatting Tags 

The Paragraph, Select, Table, and Insert item types can contain special 
commands called "Formatting Tags". 
 

Formatting Tags are entered by clicking on the formatting button .  This will 
display the Add Tag window which allows the selection of commands for Bold, 
Underline, Italics, and more. 
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Add Formatting Tag window. 
 

Tag Function 

<B> Turns On Bold text. 

</B> Turns Off Bold text. 

<I> Turns On Italics text. 

</I> Turns Off Italics text. 

<U> Turns On Underlined text. 

</U> Turns Off Underlined text. 

<LEFT> Left justifies text after this command. 

<CENTER> Center justifies text after this command. 

<RIGHT> Right justifies text after this command. 

<BR> Inserts one carriage return (i.e., same as pressing Enter 
key) 

<TAB> Inserts one Tab Stop. 

{ } Enclose words that you would like randomly selected with 
brackets. 
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In the example shown below the words "Chief Complaints" are bracketed by a 
Bold command (<B>) command and a Bold Off command (</B>). 
 

 
 
In this example the one of the bracketed phrases, "presents with" or "complains 
of", will be randomly selected as part of the sentence. 
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Creating a New Report Template 

Steps To Follow (Creating a new template) 

Before you can create new report templates the QuickReport program must be 
started. 
 
To Start QuickReport from within the Sierra Wave program: 
 

From the File menu, select Launch QuickReport & Select Template.  This 
selection is only available if a patient data file is open. 

 
To Start QuickReport stand-alone: 
 

Double click on the QuickReport icon on the desktop.  When QuickReport 
is started as a stand-alone program you can easily edit templates but be 
aware that generated reports will not contain any Sierra Wave tables, waves, 
or patient information. 
 

 
QuickReport Icon. 

 
 

To Create a New Report Template, follow these steps: 
 
1.  From the Select Report view, perform one of the following. 
 

 Select Create New Template from the File menu. 

 or, Right click within the template list and select Create New Report 
Template from the pop-up menu. 

 
The Edit Report Template Information window will be displayed. 
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2.  Enter Template Information. 
 

 Type in a Name for the template. 

 Type in a Description for the template (optional) 

 Select a template Category, typically this will be Sierra Templates. 

 The Template ID will be created automatically. 

 The Owner ID will be entered automatically. 

 Click OK. 

 The new template will be listed in the Select Report view. 

 

 
 
 
3.  Edit the Contents of the New Template. 
 

 Right click on the new template name and select Edit "template name". 
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 The Edit Template view will be displayed.  The available items are listed 
down the left hand side of the window and an empty item list is displayed 
down the center of the window. 
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Empty Template 

 
4.  Insert the first Item. 
 

 Locate the item you want by expanding the appropriate item category in 
the Available Item List.  This is done by clicking on the plus sign (+) in 
front of the category.  Clicking on the minus sign (-) will contract the 
category. 

 
 Using the left mouse button, Drag the report item and Drop it onto the 

Template's Item List in the center section of the screen.  Typically the first 
item will be an Insert Margins item. 
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New template with Insert Margins item added. 
 

 
 Decide if the item should be Auto-Selected.  All items that do not require 

user interaction during report generation should be marked as Auto-
Selected items. 

 
5.  Insert the next Item. 
 

 Drag the next item from the Available Item List and drop it onto the 
Template's Item List.  The second item will be inserted below the first item. 
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6.  Continue to insert items until the template is complete. 
 

 The order of the items can be changed using either the Drag & Drop or 
Cut & Paste methods. 

 
The example shown below is the completed template called Full Report.  It 
contains three non-Auto Selected items. 
 

 
 

Completed template. 
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7.  Set Template Control Check boxes. 
 

 

 
 

Control Check boxes shown at the bottom right of screen in Edit mode. 

 
Auto Start 
This box should normally be checked if there are any non-Auto Selected 
items in the template.  This will cause QuickReport to automatically pop-
up the first non-Auto Selected item in the template after the template is 
selected for report generation. 

 
Auto Advance 
This box should be checked if there are more than one non-Auto Selected 
items in the template.  This will cause QuickReport to automatically 
advance to the next non-Auto Selected item in the template after the first 
one is completed. 

 
Auto Create Document 
This box is normally checked for all templates.  This will cause 
QuickReport to automatically go to the Document view upon completion of 
all the items in the template.  This box should even be checked when the 
template contains all Auto-Selected items. 

 
Auto Save 
If this box is checked the report will be generated and automatically saved 
to the default Data folder.  There will be no opportunity to view the report 
in the Document view.  This box can only be used with templates that 
contain all Auto-Selected items.  This box is not checked for any of the 
factory default templates. 
 
Auto Print 
If this box is checked the report will be generated and automatically sent 
to the default printer.  There will be no opportunity to view the report in the 
Document view or to save the report.  This box can only be used with 
templates that contain all Auto-Selected items.  This box is not checked 
for any of the factory default templates. 
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Auto Protect 
If this box is checked the generated report will automatically be displayed 
in "protected" mode.  This allows templates that contain Word forms (e.g., 
check boxes, lists) to be completed but not altered. 

 
8.  Save the template.   

 Click the diskette icon , select Save from the File menu, or click the 
Save button. 
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Utilities 

Preserving Report Templates 

A preserve file can be created from within the Sierra Wave Program that contains 
the current user's test protocol settings and all the report templates. 
 
To make a Preserve File: 

1. Start the Sierra Wave program. 

2. From the File menu, select Preserve. 

3. A standard Save As window will be displayed with the location of the 
"Save In" field defaulting to the current user's Setup folder (e.g., 
Setup.username).  The filename for the preserve file is automatically 
created but can be changed to something more descriptive, like the user's 
name. 

 

 
Save As window for Preserve Settings. 

 

4. To create the preserve file in this location, click the Save button.  If you 
want to create the file in a different location, use the drop-down arrow of 
the "Save In" field to change the location prior to clicking the Save button. 
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  Preserve files have the file extension, prs. 

Restoring Report Templates 

Report Templates are restored from a preserve file using a utility within the Sierra 
Wave Program. 
 
To Restore Selected Report Templates: 

1. Start the Sierra Wave program. 

2. From the File menu, select Restore, then click on Selected. 

3. A standard Open window will be displayed with the location of the "Look 
In" field defaulting to the current user's Setup folder (e.g., 
Setup.username).  All preserve files in this location will be listed. 

4. Select the preserve file and click the Open button.   The Sierra Wave 
Restore Utility window will be displayed.  This window will default to the 
Sierra Wave view. 

5. Click on the QuickReport tab.  The Select Report(s) section will display 
the report templates and report items that are available in the preserve 
file.  You can expand a category by clicking on the (+) sign in front of the 
category name, this will show you the individual report templates or report 
items contained within the category. 
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Restore Selected QuickReport Templates and/or Items. 

 

6. To restore All Templates and Items. 

 Click on the Restore All button. 

7. To restore Selected Templates and Items. 

 Expand the appropriate categories by clicking on the (+) sign in front of 
the category name. 

 Click on the box in front of the template or item name to select it, a 
check mark will appear to indicate it has been selected. 

 Click on the Restore Checked button. 

8.  Click the OK button to close the Restore window. 
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Assigning Report Items to Sierra Wave 
Custom Fields 

 
The Sierra Wave's Patient Information window can be customized by adding up 
to 20 user-defined fields.  These fields are displayed at the bottom of the patient 
information window and can be of varying lengths. 
 
To setup the custom patient information fields, start the Sierra Wave program, 
then select System Setup from the Edit menu. 
 
The Custom Patient Info section lists the custom fields that are currently 
defined for the system. 

Up to 20 fields can be created and there are 5 types (length) to choose from. 
 The information entered in these fields can be transferred to your report. 
 

 
Name: 
Enter the name of the Custom Field.  To change an existing field name, 
click on it with the mouse.  To enter a new field, click on the blank blue line 
at the bottom of the list. 
 
Type: 
Click here to specify the length of each Custom Field.  Choices are Short 
(15 characters max), Medium (40 characters max), Long (110 characters 
max), Paragraph (unlimited characters), and Report Item.  A selection of 
Short, Medium, Long, or Paragraph for a custom field will setup a simple 
text box in the patient information window. 
 
If  Report Item is selected an additional column will be displayed.  This 
additional column, titled Report Item, allows you to assign a QuickReport 
Item to this custom field.  Simply click within the Report Item column and 
the Select Item window will be displayed.  This window displays all the 
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available Narrative, Paragraph, and Select items that are stored within 
QuickReport's database.  Only one report item can be assigned to each 
custom field. 
 

 
Select Item window. 

 

Using a Report Item with a Custom Field 
When a report item has been assigned to a custom field, the label of that 
report item and a small document icon will be displayed above and to the left 
of the custom field in the patient information window.  The user still has the 
option of simply typing into the custom field, or they can click on the report 
item's name and process that item.  This gives the user the ability to 'pre-
process' the report item before starting the report generator. 
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Patient Information window. 

 

Clicking on the Complaints item , in the above example, will pop-
up the typical QuickReport window for that item which is shown below. 
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Chief Complaints report item. 

 

You can complete the report item in the normal fashion and when the OK 
button is clicked the output of the report item (i.e., the data in the blue preview 
box) is inserted into the custom field in the patient information window. 
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Patient Information window with the Patient Complaints, Medications, and Patient 

History/Exam custom fields completed. 
 

    If you click on a report item a second time, it will simply add the results to 
the end of the text already inside the field. 
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Report Header 

The Report Header is the information that appears at the top of the first page 
of the report document.  This is inserted by using an Insert - Document item in 
the report template. 
 
The Sierra Wave program provides a convenient way to edit the contents of the 
Report Header. 
 
1.  Start the Sierra Wave program. 

2.  Select System Setup from the Edit menu.  The report header setting is 
located in the preferences area. 

 

 

 

3.   Click the Edit button to open the currently selected Report Header using 
Microsoft Word.  After making changes be sure to select File - Save before 
closing Word. 

Use the Browse button to locate a different report header or click the drop-
down arrow to select from a list of the most recently used report headers. 

4.  Click OK to close the System Setup window. 





 

145 

Report Keys (Print & Report) 

The Sierra Wave base unit has two dedicated keys that can be programmed to 
start QuickReport and load a specific report template.  These two keys are 
named Print and Report. 
 
To change the report templates assigned to these keys start the Sierra Wave 
program and select System Setup from the Edit menu. 
 
In the Report Key Assignment section click the Select button, then click the 
plus sign (+) next to report category; highlight the report template name and click 
OK.  You can also assign “Use Menu” to a key, this causes QuickReport to 
launch and stop at the Select Report view so that you can select any template on 
the system. 
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QuickReport Formatting Guidelines 

Rule #1 - There are no automatic line breaks after Items within a Narrative.  You 
must put carriage returns into the individual items. 
 
Rule #2 - If a Narrative item has a heading entered for it, there will be an 
automatic line break before and after the heading.  If numbering is enabled, there 
will be an automatic link break after each item. 
 
Rule #3 - In a Paragraph item, a space is not needed at the end of a line of text 
that comes before a choice box. 
 
Rule #4 - In a Paragraph item, a space is required at the beginning of a line of 
text that follows a choice box. 
 
Rule #5 - In the Fill In Report view, black colored lines indicate items that have 
already been processed and will be included in the report.  Green colored items 
indicate items that have not been processed.  The exceptions to this rule are 
Paragraph items that contain only carriage returns and Sierra items, both of 
these are always displayed in green color. 
 
Rule #6 - A manual Page Break item needs to have a blank line after it. 
 
Rule #7 - A manual Page Break doesn't work when placed immediately before a 
Sierra - Table item, you need to put a Carriage Return item in between these two 
items. 
 
Rule #8 - If a template contains a Sierra - TD Waves item followed by a Sierra - 
TD Tables item, place a table format item (i.e. Times 9pt) before the Sierra - TD 
Waves item in the template. 
 
Rule #9 - A Table item automatically inserts a blank line before and after the 
table. 
 
Rule #10 - An Insert item automatically inserts a blank line before and after each 
picture, but no blank lines for documents or other inserted items. 
 
 
How to put blank lines between items in the template. 

 insert Carriage Return items in the template. 
 place carriage returns within an item (i.e., press the Enter key within a text 

box). 
 place the BR formatting tag within an item. 
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QuickReport Installation Folders 

The QuickReport installation creates the following folders. 
 
C:\Cadwell\QuickReport - this folder contains the main QuickReport application 
and its associated files. 
 
C:\QMWorkStation\SierraWave0D4E4EA\Data3 - this folder contains the report 
template and item database.  The database is named "wsQuickReport.qxp". 
 
C:\QuickMedApp\Images - this folder contains some image files used by the 
program and the QuickReport Help file. 
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